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1. WELCOME TO FEMAP
1.1 FEMAP DOCKABLE PANES

Femap contains several “Dockable Panes” that offer different tools used to create and modify models,
evaluate and sort data, create reports, and view info of specific entities. Each dockable pane can be either
visible or hidden by using the Tools menu command corresponding to the specific pane.

- 5
W Femap with NX Nastran - [Model1] - [Predictive Enginesring] [ [ B ]
— i File Tools Geometry Connect Model Mesh Meodify List Delete Group View Window Help -8 X
Tools | Geometry Connect Mo Wi - s slineg 8- N eRel § g Custom Tools
Undo trl+ Z P A | S| ST T D A x@g&!igﬁap Right &, Front §™* Bottom J. Left §*Back f, lsometric {7 Dimetric fier Trimet !
Redo CtlsShiftsZ ] fablarcliol 4 % Predictive Engineering .
A G T
{4 Workplane... F2 L Coordinate Systems
Model Info 1 0 Geometry
& Connections
&l Meshing Toolbox 1 % Aero Model
. H Model
@ PostProcessing Toolbox &7 Analyses
I} Charting 2] Results
= = E] Views
| Entity Editor B Groups
 Data Surface Editor £ Layers
Entity Info I Selection List '_
1 Data Table g |
. ) '0'
» b N
rogramming .
Other Windows » U 18
Toolbars 3
Ei Parameters...
Convert Units...
Ix | Variables... Ctrl+L
Loading Parasolid Geometry Engine...
g L rs. Femap with NX Nastran Version 11.1.1
BYers... Copyright © 2014 Siemens Product Lifecycle Management Software Inc. All Rights Reserved.
L Tee Full OpenGL Hardware Acceleration (Double Buffered)
Your card supports OpenGL 4.
Measure 3
Mass Properties » || €] Model Info [ 3] Meshing | g PostProcessing
Section Properties 3 i Entity Info 3 x
Check 13 E
#| Stress Wizard x
Ready Propi0 L0 Com0 Grp:0 Outl

P

Applied CAx

We do this every day

Please Share with your Colleagues

Page 2 of 20



FIVI: BLEHELT ANASSIS @ Femap v11.1.2 and NX Nastran v9.1 Date: 5/29/2014
Predictive Engineering

1.2 TOOLBARS

Femap has many useful toolbars that help you perform a variety of different functions. The toolbars
contain icons representing certain commands and are grouped together by functionality. Each toolbar can
be made visible or hidden using the Tools > Toolbars menu command, then choosing a particular toolbar
from the list. When the toolbar is visible, it will have a check mark next to the toolbar name on the menu.
Once the toolbars are visible, they can either be “docked” around the edge of the Femap interface or
“floating” somewhere inside the Femap interface.
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1.3 PREFERENCES
This command allows you to customize the operation of Femap. These options control how certain
commands will operate, set defaults, and define disks or files to be used. This command bring up a
“tabbed” dialog box with 10 tabs, each tab representing the type of entity you want to modify.

Geometry Model I Interfaces I Results I Library/Startup | Calor | Spaceball
| Views I Graphics | User Interface | Database
Dockable Panes
[T Animate Fly-Out
|:| Captions Always on Top
[~ remember Dizlog Positions Alternate Docking Symbols
[ Alternate Accelerator Keys for Views [|Enable Legacy XY Plotting
[ Ak for Confirmation Before Delete
["] show Angles as 0 -= 360

Fast Qutput Delete 1..Fast (No Undo) ~

Recently Used Files 4

Model Info
Max Entities 2000
Create Automatic Titles

Graphical Selection Show Entities Defaults
Track Mouse Picking () Highlight
[ Pick &ll Inside (@ Transparent Highlight

Pick Method 0. .Pick Mormal - () Show Selected Cnly

Tooltip Delay 10 [T Show Labels ] Mormals

Tooltip Duration 100 Highlight Color 24600

Mouse Interface International Localization

Rewverse Mouse Wheel Direction Use Region Decimal/List Symbols
[ middle Buton Click for QK

|| shift for Pan, Ctrl for Zoom
Wheel Factor for Dynamic Planes 1,

Toolbars

[ Save Layout... ” Load Layout... ]

Reset User Interface. .. |

Meshing Toolbox ’
Expand Active Tool Only

AutoRemesh Mode | 0,.Auto Remesh - l Reset Dialog Positions l

Reset Al |

&,

Apphed CAXx Please Share with your Colleagues Page 4 of 20

We do this every day



FIVI: BLEHELT ANASSIS m Femap v11.1.2 and NX Nastran v9.1 Date: 5/29/2014
Predictive Engineering

2. ANALYSIS WORKFLOW
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2.1 GEOMETRY

Import geometry or create your own within Femap.

e  ACIS Solid Model Files - *.SAT files

. Parasolid Solid Model Files - *.X_T files

e  IGESFiles - *.IGS files

e  STEP Files - *.STP files (AP203 and AP214 geometry)
e  Stereolithography Files - *.STL files

e  Wireframe Files - *.DXF files.

e  CATIA V4 Models - *.MDL files

e  CATIA V4 Express Files - *.EXP, *.DLV files

e  CATIA VS Files - *.CATP files

e |-DEAS Files - *.IDI files

o Pro/ENGINEER Models - *.PRT and *.ASM files

. Solid Edge Models - *.PAR, *.PSM, *PWD, and *ASM files
. Unigraphics Models - *.PRT files

=
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2.2 MATERIAL

Load a material from one of several Femap libraries or create your own. Don’t include unnecessary
material data. Be mindful of your unit system. We recommend that you change the default material
library to one of the more specialized libraries located in the Femap directory.

i Bl i ™y
Define Material - SOTROPIC [ 57 Select From Library BN
D 4 Title  AISI 4340 Steel Color 104 Layer 1 Library Entry [ Choose Library... ]
General | Function References I Nonlinear I Ply/Bond Failure | Creep I Electrical {Optical | Phase | |
Stiffess Limit Stress AISI 4340 Steel -
15-5PH Stainless H1025 i
Youngs Modulus, E 29000000, Tension 215000, 17-4PH Stainless H1025
Shear Modulus, 6 0. . [2a0000. 2024-T351 Al Plate . 25-.5
Compression 6061-T651 Al Plate . 25-2,
Poisson's Ratio, nu 0.32 Shear 156000, F050-TE51 Al Plate . 25-.5
F075-T651 Al Plate . 25-.5
Thermal Ti-GAl-4V Sol Tr & Aged .
) AISI 1025 Carbon Steel
E Coeff =
xpansion Coeff, 3 6,666 Mass Density 7.33145E-4 ATSI 4130 Steel 1
Conductivity, k 4.85111E-4 - Stainless Steel Annealed
) Damping, 2C/Co  O- Magnesium AZ3 15
Spedific Heat, Cp 0.1 Magnesium ZKE0A
. Reference Temp 70. N
Heat Generation Factor 0. Titanium, Pure
AZ286 HRES Iron Alloy
Hastelloy X
Inconel 600 i
Rene 41
Beryllium
Beryllium Copper
Nonlinear 18
FinrDian
Values in Library files distributed with FEMAP are believed to be correct but have not been verified.
You must verify these values are correct and appropriate before using them for any purpose.
[ Load... ] [ Save... ] [ Copy... ] [ oK ] [ Cancel EIS [ Delete ] [ OK ] ’ Cancel
L L
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2.3 PROPERTY

Generate property types appropriate for your geometry.

r N
Define Property - BEAM Element Type |
6051 25 v [ A
o1 i W poer Angle Stiffener] Material 1..6061-T651 Al Plate .25 Define Property - PLATE Element Type @
Color 3 Layer 1 Elem/Property Type... i i
I ..7050- v |5
Property Values Strass Recavery (2 to 4 Blark=square) D[ 101 Tt | TRERUG Material 3..7050-T651 Al Plate ~ | Define Property - LAMINATE PLATE Element Type [
[7] Tapered Beam End A EndB . . Color 50 Layer 1 Elem/Property Tyge...
Area, A 0.121094 | 0. D & i1 Sl “omposite Shell MMaterial e
EndA1 -0.273185  -0.273185 Property Values Additional Options
Moment of Inertia, Tiorlzz 0.0118724 | 0.
TR, e 2 0.726815  -0.273185 Thicknesses, Tavg or T1  0.04 Bend Stiffness, 121/T*%3 0. Color 110 Layer 1 [ ElemProperty Type... ]
I2orlyy 0.0118724 [0. & Mozimees o oot
I2orizy 0.007088 0. . 0‘273135 0.726315 blank or 72 0. TShearMem Thickness,ts/t 0. Laminate Definition Laminate Properties Failure Theory
Torsional Constant, 3 0.000163 | 0. ' ’ blank or T3 0. Bending 0. Flate Materisl M Layup 1..8-ply Glass EP - M.5.MassfArea 0.
[ Transverse Shear 0..Plate Material -
¥ Shear Area 0.0625 0. EndE L [, 0. blank or T4 0. s BondShr Allow 5000
7 Shear Area 0.0625 0. 2 [o. ) Memb-Bend Coupling  0..Mone - Ignore - [ offset Bottom Surface 0.
Nonstructural massfarea 0. Ref Temp 0
Nonstruct mass/length 0 0 30 0 Mean Dilatational Formulation Options  0..As Specified -
Warping Constant 0. 0. 4 [o. f) Damping 0.
Perimeter 0. 0.
¥ Neutral Axis Offset 0.203185  0.233185 Stress Recovery ( Default=T/2)
Z Neutral Axis Offset 0.293185 0.293185 Shape EndE... [E] Top Fiber o [ Loag... ] [ Save... ] [ oK ]
Load... ] [ Save... ] [ Copy... ] [ oK ] [ Cancel ] [TJBottom Fiber | 0. [ Copy... ] [ Cancel ] Load... ] [ Save... ] [ Copy...
& L (8
2.4 MESH SIZING
Choose your mesh sizing method according to the element type you want to use.
" n
Automatic Mesh Sizing s
Size For
- ~ Tet Meshing: Hex Meshing
Automatic Mesh Sizing ﬂ
Basic Curve Sizing Surface Interior Mesh Growth
Initial Sizing Surface Interior Mesh Growth P o 1eee7 [l Growth Factor T
Element Size 2.91316| [l Growth Factor 1 ) Curvature-Based Mesh Refinement
eplace Mesh Sizes on All Curves B
i N || Replace Mesh Sizes on All Curves X Refinement Ratio Cio
Mesh Size Along Curves ﬂ - 3 ) Curvature-Based Mesh Refinement Min Elements on Edge 1 Refine Surface Mesh
Min Elements on Edge 1
Mesh Size Node Spacing [7] refinement Ratio 0.1 FafreEem: = Assembly / Multi-Solid Sizing
Max Angle Tolerance 25, Refine Surface Mesh Max Elem on Small Feature 6 [T Adjacent Surface Matching
(7 Number of Elemerts Max Elem on Small Feature [ [ Max Size of Small Feature 0.166667 Remove Previous Slaving
[T Max Size of small Feature 2.91816 [ Vertex Aspect Ratio EX Adjust Colors
" B 13 Biaz Fact 1 [ skip Sizing on Slaved Surfaces
Min Elem on Lines 1 e || vertex Aspect Ratio 3. Suppress Short Edges 1 %
Min Elem on Closed Edges 12 L EoEEalEsl Suppress Short Edges 1 % [l uto Boundary Small surf 1. |-
Min El Other Ed 3 Small Blements at End R 2
in Elem on Uther es i Mappes iesning Refnement
gy Small Flements at Center Mapped Meshing Refinement [ — ] [ —
Small Blements at Both Ends SzngType |2 ParameticEquallength ~| [ ok | [ cancel Sz Type | 2..Parametric/Equal Length ¥
L e L
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2.5 MESHING

Finite elements can be classified as point (0-D), line (1-D), planar (2-D) and solid (3-D) elements.

J 0-D elements (e.g., point masses) are created on one node and can be meshed on geometric points.
J 1-D elements (e.g., beams) are created on two nodes and can be meshed on geometric lines.

J 2-D elements (e.g., plates) are created on three (triangular) or four nodes (or quadrilateral) and can
be meshed on geometric surfaces.

J 3-D elements (e.g., solids) are created on a minimum of four nodes (tetrahedral) or eight nodes

(hexahedral) and can be meshed on geometric solids.
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2.6 LOADS

= Model
+ &5, Materials
(= 1 Properties
s Layups
= & Loads

&l O 1..Load Sek
E '5- Load Definitions

%= 1{..Force on Node
"ﬂ: 2..Moment on Node
"'9; 3..Temperature on Element
*— 4, Rotational Velocity on Point
"?: 5..Faorce Per Node on Curve
"'9: 6..Prassure on Surface
%— 7..Bolt Preload on Region
= 3 Body Loads
3 Accekeration (0.,0,,32.2)
3 Rotational Acceleration (6,,0.,0.)
3 Rotational Velocity (15.,0.,0.)
3 Default Temperature (70.)
= ﬁf’ Other Loads

= & OnGeometry
‘ Force Per Area on Surface S

= & OnMesh
< Force on Node 950
& Force on Node 986

= ' Bolt Preload
' Eolt Preload on Reqion 2

= 3 Nodal Temperatures
)& Temperature on Node 183
sl Temperature on Node 236

= Eﬂ Elemental Temperatures
gl Temperature on Element 521

Every time a load is created on finite element entities (i.e., Model,

Load, Nodal; Model, Load, Nodal on Face; and Model, Load,

Elemental) or geometry (Model, Load, On Point; Model, Load, On
Curve; Model, Load, on Surface) a “Load Definition” will also be

created in Femap. A Bolt Preload will also create a Load
Definition. These Load Definitions will appear in the Loads branch

of the Model Info tree and can be given a title.
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2.7 CONSTRAINTS

Every time a constraint is created on finite element entities (i.e., Model, Constraint, Nodal; Model,
Constraint, Nodal on Face; and Model, Constraint, Equation) or geometry (Model, Constraint, On Point;
Model, Constraint, On Curve; Model, Constraint, on Surface) a “Constraint Definition” will also be created
in Femap. These Constraint Definitions will appear in the Constraints branch of the Model Info tree and
can be given a title.

7

Editing Constraint Definition

[m—ts=]]

Constraint et 1 Pinned

Title Constraint on Surface

Color 120 Layer 1

Standard Types

(@) Pinned - Mo Translation
() Mo Rotation
Advanced Types
() Arbitrary in CSys -1..Modal Cutput CSys
T TY TZ RX RY RZ
(71 Surface Indude Rotational DOF
Allow Sliding only along Surface (Symmetry)
Allow Movement Mormal to Surface (AntiSymmetry)
Allow Sliding only in Spedfied Direction
(71 Cylinder / Hole
Constrain Radial Growth

Constrain Rotation around Axis

Constrain Sliding along Axis

IH
e

Cancel
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2.8 ANALYZE
As they say in the Femap help file examples: “THE MODEL IS NOW READY TO BE ANALYZED!”

F ™
B ' Analysis Set Manager (Active: 1..Glued Contact) E@g
- Modal Elemental
(=R Analysis Set : 1..Glued Contact
- Solver : N¥ Mastran = gsplacement 0..Full Model - [#]Force 0..Full Model -
- Type ! Static Analyze Multiple... [7] Applied Load 0..Full Model +  [7]stress 0,.Full Model -
- Analyze : Local =
=- Options ConstraintForce  O..Full Model *  []stain 0..Full Model
[ Executive/Solution -
: - : 0..Full Model = 0..Full Model
B Bulk Data [~] Equation Force [ strain Energy
[ GEOMCHECK. : ["Force Balance 0..Full Model Heat Flusx 0..Full Model
__ MODELCHECK Preview Input = -
: i 0..Full Model 0..Full Model
[+- External Superelement Reference [ velocity Enthalpy
[=]-Master Requests and Conditions MultiSet. .. [ Acceleration 0..Full Model Enthalpy Rate 0..Full Model
i Title : Untitled
i e 0..Full Model 0..Full Model
[ External Superelement Creation Kinetic Energy e Temperature e
EI B?undary Conditions Temperature 0..Full Model Kinetic Energy 0..Full Model
¢ i-Consfraints : 1..Pinned = o..Ful Moddl
i ‘wLoads: 1..Normal Force Ersigiy iss ST ees
[#- Output Requests Fluid Pressure 0..Full Model
- Mo Cases Defined
Element Corner Results Results Destination
Cutput Modes | a,b,c THRU A ) 2..PostProcess Only -
: Echo Model
|
(@) Magnitude /Phase Real/Imaginary
Done Relative Enforced Motion Results

App'léd CAX Page 12 of 20

We do this every day



FIVI: BLEHELT ANASSS m Femap v11.1.2 and NX Nastran v9.1 Date: 5/29/2014
Predictive Engineering

3. TIP, TRICKS, NEW FEATURES
3.1 MEASURE BETWEEN GEOMETRY

This function measures the minimum or maximum distance (or both) between two sets of selected
geometric entities.

[—
Distance

Distance toFind ~ From To l
IS C) Point Q Point
@ Minimum; - =
i © Curve e
() Maximum
) surface () Surface
(") Both _ _
@ Solid @ Solid oK
Overall Only Overall Only Cancel
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3.2 SELECTOR BLANKING

This method allows the user to blank/un-blank entities from the Femap window using the Selector tool.

R R R AN R Nm .

s Mew

Activate
List

Delete
Renumber

Group

Automatic Connection

Mesh Size
Attributes
Tet Mesh
Hex Mesh

BE Begx2

| Visibility

|

Show Selected Only

Oe

-

=

)

=

Hide Selected

Show All
Hide All
Show/Hide Reverse

N
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3.3 LOAD FROM FREEBODY

This technique creates loads directly from a freebody display. The “Multi-Model” option allows the
analyst to generate the loads within a separate model file. This option also facilitates the generation of
RBE3 elements to assist in applying the freebody loads to a model with a finer mesh.

13
X
Z

Freebody: Section Cut o Freebody: Section Cut

0z

Output Set: NX NASTRAN Case 1
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3.4 MODEL MERGE

The File > Merge command allows entities from any model currently open in the same instance of Femap
to be “merged” with the active model. At least two models must be open for this command to be
available. To facilitate bringing entities into the active model, a number of overall Renumbering and
Duplicates Strategy, Entity Selection, and Model Orientation options are available in the Model Merge
Manager dialog box.

-

i " Model Merge Manager .

Merge Extract
From Model odel Merge Test 2. modfem - ToModel | Model Merge Test 1.modfem
Entity Type | Current IDs | Merge IDs Renumber To Renumbering | ol All On
Paint 10,121 10..121 1,93 55 of 56 all off
[¥] curve 6..38 6..38 1.58 28 of 28 E
Surface 1..15 1..15 16..30 150f 15 Select Al
Coordinate System 3.3 3.3 4.4 1of1 —
Mode 1..387 1..645 15..645 F2of 471
Element 1..284 1..1564 285..1564 12of 620 Update Selected
Material 1.3 1.3 4.6 30f3
[7] Pronerty 1..104 1,104 G..14 anfa i Update Al
Renumbering and Duplicates Strategy Entity Selection
() Mone (@ Renumber Duplicates ) None @ All In Model l Add Referenced Entities I
|3?:I Minimal Renumbering (7) Overwrite Duplicates @ From Group
(") Block Renumbering
() Offset Renumbering (Z) 1D Range From |1 To | 99999999
(7) Compress Renumber To 1 (7) Select

Model Orientation
Create Group for Merged Model [ Transform Merged Model
|| create Parent CSys for Merged Model From | 0..Basic Rectangular
[~ condense Transferred Groups
Limit Loads, Constraints and Contact to Merged Entities

To | 0..Basic Rectangular

Duplicates to Data Table

= /:&

-
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3.5 RENUMBERING ENTITIES FROM THE MODEL INFO TREE

For the analyst with a touch of OCD... You can now renumber selected entities from the Model Info Tree.
This method renumbers entities in the model by attempting to use the specified ID to start. If specified ID
to start is already used, Femap will use next empty ID instead until all selected entities have been
renumbered.

Medel Info =
BER| P 5 4
J\ Coordinate Systems
0 Geometry
‘ Connections
- Aero Model
=-E Model
- Eements
-5 Materials
[j---l Properties
..... s Layups
=@ Loads
O 1..Dead Weight: Materials
0 2..Dead Weight: Static Head: PV Empty, PIM Full
0 3..Dead Weight: Static Head: PV Full, PJM Empty
=™ 2 4.Pressure: MIN Ves,
[ MNew
) Activate
Copy
O 5..Pressure: MAX Vess| ‘E:‘ I
O G..Pressure: MIM PJM
0 7..Pressure; MAX PIM {a} Delete
[#-48 Constraints aﬁ Renumber
""" by Functions Show Loaded Entities
[-f* DataSurfaces S
EJ-"% Anak leferenced Sets
[]--@a Results Body
D"'E_! Views Menlinear Analysis
EJ---h Groups Dynamic Analysis
[]...g Layers
___________________________________ Heat Transfer
----- [y Selection List
E Mshingl ﬁ Pos!ProcssinglE Model lnfo]
&,
=5
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4. GAINING NEW SKILLS

We have lots of seminars, how-to-guides, tutorials and API tips and tricks

C' [ www.predictiveengineering.com/downloads/seminars.html bicd—
@f Aluminum Signs, £= Greek islands - G Santorini Greece 6 PolymerFEM - C... [*] KINKFM - Triton ... il Bachella Aventur... »
e I
FINTE ELEMENT ANnaLYSIS
Predictive Engmeermg Mechanical Engineering Solutions
HOME ABOUTUS o HEWS PRODUCTS RESOURCES CONTACT FEA CONSULTING SERVICES
PRODUCTS: Latest Additions:
FEMAP
This section provides videos, example files, and class notes from our Best Practices: Femap and NX Nastran
NX Nastran online seminar series. Technical Seminar
LeDVIA Dear F: d NX Nastran Coll
Traning/Consulting Best Practices: Femap and NX Nastran Technical Seminar sarremap an asiran boleagues,
Dear Femap and NX Mastran Colleagues, We have condensed dowin our best
modeling practices and recommendations.
Predictive Engineering We have condensed down our best modehng practices and into Ims_ 50 minute seminar. It covers how
recommendaticns inte this 50 minute seminar. It covers how we verify our models for consulting clients I
SOLUTIONS we verify our models for consulting clients and provides a and provides a template on how someone i
2505 SE 11th, Suite 310 template on how someone new to FEA can proceed safely in new to FEA can proceed safely in creating
Portland Dregon 7202 creating and analyzing a structure. and analyzing a structure.
503-206-5571 I
886.215.1220 (FAX) Many of our practices may soeund routine and cemmonplace, Many of our practices may sound routing
CONTACT but over the years we have not found it te be the case in the and commonplace, but over the years we i
industrial FEA workplace. Although we may not cover every have not found it to be the case in the
check known te FEA kind we believe that if one follows the industrial FEA workplace. Although we may
guidelines given in this seminar one can aveoid 95% of the not cover every check known to FEA kind
“George, problems that we have encountered within our own modeling we believe that if one follows the guidelines.
| very much enjoyed the briefing work and that we have seen via technical support assistance. given in this seminar one can avoid 95% of
Refresher courses on these types of the problems that we have encountered
topics are helpful. It alsa confirms > Watch the Seminar on YouTube within cur own modeling work and that we
how we are approaching problems > Webinar Video Download have seen via technical support assistance.
and see how others solve them as > PDF of Seminar
well > Example files (zip) > Watch the Seminar on YouTube
> Webinar Video Download
Itis always good to have as many What is Groundcheck? Femap & NX Nastran Technical > PDF of Seminar
‘tnn!s"\n v.nur box as possible when Seminar > Example files (zip)
solving unique problems. - o
Tl (e e AT 2 Connections 2013: RBE2, RBE3 and CBUSH Elements |
understanding how the *box” is Femap v11 New Features What is Groundcheck? Femap & HX
using the equations to produce an Nastran Technical Seminar
answer. ( This is especially Fe’;‘BIP and NX Nastran Technical Seminar on Surface Dear Femap and NX Nastran Colleagues,
important for the younger engineers Modeling
DU = Femap, NX Nastran and LS-DYNA Technical Seminar: Lher; ‘”e"“ many ”%"f“”s"““m” (";Fe'm“
. Buckling Mini-Worksho nalysis Manager and for the majority o
| appreciate your unique style and d i analyses, there's no need to mess with
HErEzE W ET R 4TS wEust Femap and NX Nastran Technical Seminar: Analysis them. But as engineers, we always want to
that inspires others to push FEMAP Workflows ask "What does this do? How does it work?
and NASTRAN to its limit to see what Why is this here?” For me, the Model Check h
the code will and will not do! Femap and NX Nastran Technical Seminar: Normal Modes page of the analysis manager stired these
Analysis questions. | finally stopped automatically
Thanks for your time and effart clicking the "Next” button and started to
putting this and other types of ‘F’err:)alp vlrﬂi.a.!. and I:):\I:astran v8.1 Update i on igate the k options.
material tagether for all to use and isibility, Hexing an 1 |
the community. | appreciate the In this technical seminar we will explore the
! e Femap and NX Nastran Update Groundcheck options with some example
material and your contributions..... | — models to determing what these options do -
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5. FATIGUE ESSENTIALS

FATIGUE ESSENTIALS ™ Fatigue

Stress Life Analysis Application /oo ESSENTIALS

Fatigue Essentials is a desktop application used to
efficiently generate fatigue results for FEA.

Choose between Classic mode with user input
stresses or the Femap-linked Professional version.

APPLICATION FEATURES Classic
$695

Classic mode with user
input stresses.

* Covers most engineering requirements

e Classic mode with user input stresses

e Professional mode (FEMAP-linked) with } or ]
G ET THE APP FOR FEMAP ability to read nodal stresses and push back

results for a damage contour plot

Professional
$2750

Includes Femap link and all
Classic features.

* Intuitive user interface
 Supports multiple units (psi, ksi, Pa, MPa)
e Simple S-N curve input

» Options for Goodman, Smith-Watson-Topper
(SWT), or Walker mean stress correction

» Option for either interactive input or file
\ o input for stresses and cycles
Fa | I g l I e  Rainflow or peak counting per ASTM 1049 (800) 746-8134 ext 1

« Damage and margin of safety calculations FatigueEssentials@AppliedCAx.com

, E s S E N T I A L S e Output of analysis reports AppliedCAx.com/FatigueEssentials

CONTACT US

FINITE ELEMENT ANALYSIS m /“‘%ﬁw
(EAN}NDAE &Vsol s PredictiveEngineering  AppliedCAx
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6. TRAINING OPPORTUNITIES
e LS-DYNA Analysis for Structural Mechanics, January 2015
e Femap and NX Nastran Training, October 2014

%\\
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